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DTP-Desktop Publishing 

Introduction to DTP 

Desktop publishing applications allow you to create documents containing graphics and text on a 

computer. Business cards, flyers, brochures, newsletters and stationery are a few things that you can 

create using a desktop publisher. 

Consider the creation of a simple one-page flyer. Without a graphic artist's tools, a person 

would be limited to a typewriter, markers, scissors, glue, a ruler, and whatever else that was in the 

home that could be pressed into service. A graphic artist would have press-type, the services of a 

typesetter, knives, spray mount, technical ruling pens, a camera (sizes photos and line drawings), etc. 

These tools make the job a lot easier, but they still have their drawbacks for instance, expensive 

ruling pens are useless if you do not have a steady hand and a good eye. With desktop publishing, 

these tools have all been moved onto a computer. Not only do the tools work in the same way, but 

they are just as easy, or even easier, to use. Best of all, production time and costs drop dramatically 

with the use of desktop publishing. PageMaker and the desktop computer can help you accomplish 

tasks in minutes that once took hours to accomplish with traditional Typesetting, layout, and paste-up 

techniques. It was the first in a generation of desktop publishing software packages. 

 

Adobe PageMaker 7.0 

  

Introduction to PageMaker 

PageMaker was originally designed to facilitate pasting parts of a publication together after they 

were individually created with other software. PageMaker has some basic graphics capabilities, 

However complicated graphics should be created and edited using software specifically for graphics, 

e.g., Adobe Illustrator or Photoshop and then imported. Likewise for text. Although PageMaker has a 

basic text editor, it is best to create and edit your text in a word processor, e.g. Microsoft Word and 

then import it. 

PageMaker has a File, Place command that allows you to select the text and graphics files that you 

wish to import. 
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Create a Publication 

To open a new document, select File, New from the menu. The Document Setup dialog box will 

appear,Allowing you to change the default for this specific document. (To change the document 

setup defaults for the entire application, select File, Document Setup without issuing the new 

command or while you are in an existing document.) The values in the Document Setup dialog box 

may be changed after starting a publication. 
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Menu Bar 

 

 

 

File - Commands that affect the entire document (includes Open, Save, Place, Print, Page setup, 

Preferences and Quit). 

 

Edit - Contains Undo, cutting and pasting commands. 

 

Layout - Go to, insert, remove, and sort pages. Also controls column guides. 

 

Type – Formats the characters and paragraphs. 

 

Element - Contains a palette of line widths and patterns for lines and shapes created within 

PageMaker and a palette of shades and patterns for shapes drawn within PageMaker. 

 

Utilities - Contains the index and table of contents features and plug-ins currently installed. 

 

View - Controls the display size of your publication. Also controls rulers and guides. 

 

Window - Contains the commands to display the different palettes, the toolbox, and documents 

open. 

 

 

Toolbox 

 

The Toolbox can be dragged around just like any other window. To close it, go to Window on the 

Menu bar and select Hide Tools. To retrieve it, go to Window and select Show Tools. 
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These tools are used primarily for creation and editing of simple graphics and text. 

                                           

 

Explanation of Toolbox 

 Used to select items, text, or a location. Once an item has been selected, it can be resized,      

        moved, copied or deleted. 

 

 Enables text entry and editing. 

 

 Rotates text, drawings, or graphics. 

 

 Allows custom trimming of graphics. 

 

 Draws straight lines at any angle. See Elements, Lines for Options. 

 

 Draws horizontal, vertical, and 45 degree lines. See Elements, Line for options. 
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 Draws rectangles. To draw squares, hold the SHIFT key before Clicking and dragging. 

 

 Creates rectangular placeholders for text and graphics. To create Square placeholders; hold     

down the SHIFT key before clicking and dragging. 

  

 Draws ellipses. To draw circles, hold down the SHIFT key before clicking and dragging. 

 

 Creates elliptical placeholders for text and graphics. To create Circular placeholders, hold 

down the SHIFT key before clicking And dragging. 

 Draws basic polygons. See Element, Polygon Settings for Options. 

 

 Creates polygonal placeholders for text and graphics. 

 

 Used to scroll the page (an alternative to the scroll bar) 

 

 Used to magnify or reduce the view of your work area. To zoom out hold the ALT key before 

clicking. 
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The Pasteboard 

 

When you create a publication, PageMaker opens a window which contains a page centered on the 

pasteboard. The pasteboard is similar to the work space traditionally used by graphic artists. 
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Bullets and numbering 

 

Bullets and numbering 

This 'Plug-In' allow you to add 'bullets' or numbers to selected paragraphs in the text. Use it as 

follows: 

1. Using the 'Text' tool, click in the first paragraph to which you want to add the 

bullets/numbers. 

2. Select 'Utilities', 'Plug-Ins' and 'Bullets & numbering'. 

3. Choose whether you want to add bullets/numbers to every paragraph, a certain number of 

paragraphs, all paragraphs with a certain style, or selected (highlighted) paragraphs 

 

 

 

Bullets 
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1. For bullets, choose the type of bullet you want. If the selection offered does not appeal to 

you, click on 'Edit', and choose from the entire character set (or another set). 

2. For numbers, click on 'Numbers' and complete the dialogue box which appears. The style of 

numbering can be chosen, and the separator, i.e. the character which appears after the 

number. 

 
 

 

Then click 'OK' (or 'Remove' to remove previously placed bullets/numbers). 

Printing 

Before printing, make sure that the machine you are using is actually connected to a printer!  

Select 'File', 'Print' to obtain the following dialogue box: 
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Adobe Photoshop 

Adobe Photoshop is a popular image editing software that provides a work environment consistent 

with Adobe Illustrator, Adobe InDesign, and other products in the Adobe Creative Suite. This 

tutorial is an introduction to using Adobe Photoshop. Here you will learn how to get started, how to 

use the interface, and how to modify images with basic editing skills.  

 

GETTING STARTED 

Begin by opening Adobe Photoshop 7.0.  

On a computer click Start �All Programs � Adobe Photoshop 7.0 

Setting up the document 

Setting up your document correctly from the start will make your job much easier as you work 

through your project. This will require some advanced planning.  

To create a new document, click File ���� New. This will open the Document Setup dialog box  

11



 

 

 

 

Here you will be able to name your file, set up the correct page size and orientation for your 

document.  
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Now open an image file using file �open 

After opening file select move tools and drag opened file to your new document 
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Page Size and Orientation 

Change the page size by typing in new values for width and height. Page size represents the final size 

you want after bleeds or trimming other marks outside the page. In the Preset dropdown menu you 

can find such common sizes as letter, legal etc. Typing in exact values for Height and Width gives 

you more control over the size and orientation of your page.  

 

Resolution 

Resolution is the number of pixels on a printed area of an image. The higher resolution, the more 

pixels there are on the page, the better quality of the image. However, high resolution increases the 

size of the file. The standard recommended resolution for printed images is 150-300, for Web 

images it is 72.  

 

Color Mode 

Choose a color mode that will best fit your project. For example, when making a graphic for a web 

site, choose RGB. When making an image for prints choose CMYK.  

 

Background Contents 

Choose the background: white, color or transparent. When you have entered all of your document 

settings, click Ok.  

 

Opening an image from a disk 

If the image you have is saved on a disk or to the computer, select File ���� Open, and then navigate 

to the disk drive/file where your image is saved. Choose the image file and click Open. At this 

point, you may want to save your image under a different name so that you can always have the 

original to fall back on in case of a mistake. To save your file, select File ���� Save As and type in the 

new name of the file in the dialogue box. 
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Toolbox 
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Details of Photoshop tool 

 Move tools -Used to select and move objects on the page. Click the tool button, and then                   

           Click on any object on the page you wish to move.  

 

 Marquee- Selects an object by drawing a rectangle or an ellipse around it. Click the tool 

button; choose a rectangular or an elliptical marquee. Drag the marquee over the area of the image 

you wish to select.  

 

 Lasso - Selects an object by drawing a freehand border around it. Click the tool button, drag 

to draw a freehand border around the are of the image you wish to select.  

 

 Magic wand- Selects all objects in a document with the same or similar fill color, stroke 

weight, stroke color, opacity or blending mode. By specifying the color range or tolerance, you can  

Control what the Magic Wand tool selects.  

 

 Crop- Click the tool button, then click and drag the tool over the part of the image that you 

want to keep. Resize the selected area dragging the squares at the sides and corners. Click the 

Return/Enter key when your crop box is sized correctly.  

 

 Eye Dropper- Takes color samples from colors on the page and displays them in the Color 

Boxes. Select the tool, click on the color in the image you wish to sample. The Color Box will 

display this color. 

 

 Healing Brush-Corrects small blemishes in scanned photos. Select the tool, hold down the 

ALT key and left-click on the base color you need to heal. Then left-click over the blemish.  
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 Brush- Draws brush strokes of different thicknesses and colors. Select the tool. Then click on 

the selected area, drag to draw lines. Use the Options bar to change the brush, mode, opacity and 

flow.  

 

 Clone stamp - Takes a sample of an image and applies over another image, or a part of the 

same image. Select the tool. Hold down the ALT key and left-click on a certain point of the 

document where you want to start your copy point. Then, put your mouse over whatever part of the 

new document you want the picture to go to. Hold down the left mouse button and drag the mouse 

across the page to copy the picture.  

 

 Art history brush- Paints over an image using the source data from a specified history state or 

snapshot. Select the tool; specify the brush, blending mode, opacity, style, area and tolerance.  

 

 Eraser- Removes part of an existing path or stroke. You can use the Erase tool on paths. Text 

can only be erased when rasterized.Select the tool, click on the part of the image you wish to erase. 

Drag to erase pixels.  

 

 Paint bucket- Applies a color fill to a selected part of the image or to an entire layer. Select a 

layer you wish to apply the paint bucket to, click the tool button, click on the starting point, and click 

the area you wish to fill. 

 

 Blur -Blurs the sharp edges of an image. Select an area where you wish to apply the tool. 

Click the tool button and choose the brush, mode, and strength. Drag the brush along the edges.  

 

 Path selection- Selects paths and path segments. Select the tool, click anywhere on the path.  

 

 Type- Types text on a page. Every time you click the Type Tool on a new portion of the page, 

a new layer will be created. Select the type tool, click on the page and begin to type. You can specify 

the font and size in the Options bar. You can also resize and transform the text box by dragging the 

squares at the sides and corners. Use the Move Tool to move the text on the page.  
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 Pen- Draws smooth-edged paths. Select the tool, click on the page and drag to draw a path. 

Click and drag the anchor points to modify the path.  

 

 Hand- Allows you to move around within the image. Select the tool, click on the spot on the 

page, hold the mouse button down, and drag to move in the area.  

 

 Magnify- Magnifies or reduces the display of any area in your image window. Select the tool, 

choose Zoom In or Zoom Out in the Options bar, and click on the area of the image you wish to 

magnify or reduce.  

 

 Color Boxes- The foreground color appears in the upper color selection box and represents a 

color that is currently active. The background color appears in the lower box and represents an 

inactive color.  

1. To change the foreground color, click the upper color selection box in the Toolbox.  

2. To change the background color, click the lower color selection box in the Toolbox.  

3. To reverse the foreground and background colors, click the Switch Colors icon (the arrow) in the 

toolbox.  

4. To restore the default foreground and background colors, click the Default Colors icon (the little 

black and white boxes) in the toolbox.  

Note: If you are using the Gradient Tool, the currently selected foreground and background colors 

will be the default colors of the gradient.  
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Detailed layout of the Photoshop toolbar. 
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Edit Images with Adobe Photoshop 

Launch the Photoshop program. The Photoshop program window opens. A toolbox and palette 

windows appear on the screen. The tools in the toolbox let you select, paint, edit, and view images. 

Other toolbox controls choose foreground and background colors, and change the screen display 

mode. Most tools have associated palettes, which contain options for each tool. 

 

 

 

The first time you start the application, the toolbox appears on the left side of the screen. Some tools 

in the toolbox have options that appear in the context-sensitive tool options bar. These include the 

tools that let you use type, select, paint, draw, edit, move, annotate, and view images. 
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Correcting Scanned Images 

The quality of scanned images can often be improved. Adjust the brightness and color balance, fix a 

scratch on the picture, remove an object, resize the image, and sharpen the focus. 

Brightness and Color Balance 

1. From the Image menu, choose Adjustments and from the sub-menu Choose Variations This is a 

useful function for changing several Picture attributes. 

2. Adjust the brightness by clicking on the image and choose Adjustments 

3. Similarly, correct the color balance by clicking on the thumbnail that you like the best. Color 

balance is somewhat subjective, but you Might want to start by adding “More Green” to the image. 

4. Click on the various options until you are satisfied with the Resulting image. 

5. Click OK when you are finished 

 

Repair a Damaged Image 

On the picture, there is a scratch in. Photoshop can be used to repair the image. 

1. Refer to the Toolbar appendix, and select the Lasso tool from the toolbar. 

2. Carefully draw a circle around the scratch in image by clicking and dragging around it. 

3. From the Filter menu, select Noise, and from the sub-menu choose Dust & Scratches… 

In the dialog box that appears, you will adjust the Radius until the scratch Disappears. 

4. Place your mouse over the triangle, drag it along the line. The number in the Radius box changes. 

This will occur around 3 pixels. 

 

5. Click OK. 

The scratch is removed from the photograph. 
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6. Clear the selection, from the Select menu, chooses Deselect. 

 

 

Remove an Object 

 

Choose the Magnifying Glass tool from the toolbar (Zoom tool), 

 

 

center of the photo (see below). This will zoom into this area. 

 

 

Select the Clone Stamp from the toolbar. This tool allows you to copy one area of the picture to 

another part of the picture. The size of the area being copied is set by the size of the brush. 

 

 

Clone stamp tools ����   

On the Brushes palette, click the drop-down menu of brushes. 
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Select the line labeled this sets the brush size that we will use. 

 

 

 

First, you will select the part of the image to copy or "clone" with the stamp tool. 

Move the "clone stamp" cursor over the photo to an area just to the left or right of the rock pile. 

Hold down the ALT key  

While holding the ALT click once. Release the ALT Key. This "clones" the area that was clicked. 

 

 

 

 

Cropping and resizing 

 

Photoshop has a cropping tool that can select a part of the picture and remove the rest. Cropping can 

be used to remove unwanted parts of a picture or to focus on a particular portion of the image. 

Cropping an Image 

1. Select the Crop tool on the toolbox. 

                          

2. Move your mouse to the image, and draw a rectangle to select the desired area. & press enter  

You don't have to get this perfect the first time, the selection area can be adjusted using the handles 

on the rectangular selection. 
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Altering Images 

Change Color of an Object 

Locate and open the image.From the Image menu, select Adjustments, then choose Hue/Saturation 

from the sub-menu. 

Turn the image red by setting the Hue to -45, and the Saturation to+31. (Or play with these 

sliders to make the shoes another color.) 

 

 

                                   

Click OK. 
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Also change level, color balance, hue/saturation and curves.Go to image menu     

�adjustment�select desire option 
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Working with Layers 

When you added the text to the picture in the previous section, you also created a new “layer.” As 

new items, such as text, are added to an image, Photoshop automatically adds a new layer. Layers 

allow you to edit and position different parts of an image separately. The Layers palette displays all 

layers for a picture. 

  

1. Check the Window menu. If there is a checkmark next to Layers appears in the list, do nothing. 

Otherwise click "Layers" to display the palette. Looking at the Layers palette, you'll notice that the 

image has 2 layers. The text layer that you added is labeled with the text that you typed. 
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You can control whether the layer is visible by clicking the eye icon to The left of it. This will 

toggle it on (visible) or off (invisible). Select the layer with the text by clicking it (it's probably 

selected Already). It will be highlighted when selected. 

 

Choose the Move tool from Toolbar.  

 

Click anywhere on the image and move the mouse. 

Only the image will move because only its layer is selected. Layers often contain text or a portion of 

an image. Effects can be added to a layer to enhance its appearance. 

 

 

To add a Layer effect to the text layer, from the Layer menu, choose Layer style, and then choose 

Drop Shadow. 

 

 

 

In the dialog box, click OK. The text layer now has a shadow effect 
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CorelDraw 

Opening CorelDraw 

1. When CorelDraw is loaded, a new section is created on the Start Menu. To open 

CorelDraw, click the Start button from the Taskbar. This opens the Windows Start menu. 

2. Select Programs from the list. This activates the Programs panel. Programs are contained in 

groups, but rather than being initially displayed in a group window, each group is listed. 

3. Find the Corel section and select CorelDraw 12.This opens up the program with the 

CorelDraw welcome screen. If you have used the program before, you may have turned off 

this screen.  
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Choose Open Graphic or use the Open command on the File menu.  

New Graphic creates a new, one page document. Open Last Edited opens the last document you had 

open. The splash screen will show the names of the files over the icon. The Template icon allows 

you to access many professionally created templates you can then modify for your own projects. The 

Corel Tutor gives you a brief overview of how to use the program and what’s New? Shows you all 

the improvements from Version 11. Designer.com connects you to the Corel Designer.com web site 

where you can find many helpful areas. If you clear the check from the box in the lower left corner, 

you will not see this graphic but will open a new file when you open the program. 

 

The CorelDraw Window 
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Tool Overview 

The Toolbox is located in the left portion of the window and contains all the drawing and editing 

tools necessary to create objects for an illustration. Tools containing a small triangle in the corner 

produce a Flyout. Flyouts contain additional tools or tool options and are explained below in the 

order they appear on the default screen. Flyouts are described following the Tool Overview. 

 Pick Too- Selects objects or groups of objects. Once selected, you can use the Pick Tool of 

move, stretch, scale, rotate, and skew objects. 

 Shape Tool- Reshapes objects. Objects are reshaped by moving nodes, lines, and control 

points. 
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 Zoom Tool- Changes the current view of the drawing. You can also select magnification 

options from the Property Bar in the Zoom mode. 

 Freehand Tool- Draws lines and curves. You can also use this tool to trace bitmaps. 

 Smart Drawing Tool- Converts the freehand strokes you draw to basic shapes and smoothed 

curves. 

 

 Rectangle Tool -Draws rectangles and squares. Squares are created by using the Control key 

while drawing. 

Ellipse Tool- Draws ellipses and circles. Circles are created by holding down the Control key as 

you draw. 

 

Graph Paper Tool- Draws a collection of boxes that simulates a sheet of graph paper 

 

 

Perfect Shapes Tool- A collection of objects which you can add to your drawing. They include 

such things as arrows, stars, talk bubbles, and flow chart symbols. 

 

 

Text Tool- Adds either Artistic or Paragraph text to your drawing. 

 

 Interactive Blend Tool- The Blend Tool allows you to merger objects together through a series 

of steps. The flyout gives access to several more interactive tools that are described on the following 

pages. 

 

 Eyedropper Tool- The Eyedropper Tool allows you to select a color within an object, 

especially a bitmap, and allows you to apply that color to another object. You can also capture the 

color for a customized palette. The flyout gives access to the paint bucket that applies the color. 
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Outline Tool- Sets the outline style of an object or a line. This includes the line type, ends, 

color, and weight. The flyout gives quick access to some changes. 

 

Fill Tool-Assigns the fill style of any object. Fills are only visible on closed objects. The flyout 

gives access to control dialogs for each type of fill. 

 

Interactive Fill Tool-Allows you to apply Fountain fills (gradients) using the mouse. The flyout 

gives access to the Mesh fill Tool. 

 

Flyouts 

Tool buttons containing a small triangle in the lower right corner display Flyouts. Flyouts are used 

by CorelDraw to display additional tools. They are activated by holding down the tool button with 

the mouse. 

The details below are not meant to be a comprehensive look at each tool Flyout, but rather a 

reference. 

 Shape Edit Flyout -Holds Shape Edit, Knife, Smudge, Roughen, Free 

Transform and Virtual Segment Delete Tools. 

 

Zoom Tool Flyout-Holds the Zoom Tool, which is used for changing the view 

magnification, and the Pan Tool, which is used for moving the drawing page around the display area. 

 Curve Flyout-Holds the Bezier Tool, Artistic Media Tool, 

Dimension Tool and the Connector Tool. Each tool is used to create specific types of lines. 

 Rectangle Tool Flyout-Holds the Rectangle tool and the 3-point Rectangle tool 
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 Ellipse Tool Flyout-Holds the Ellipse Tool and the 3-point Ellipse Tool. 

 Object Flyout-Holds the Polygon Tool for creating multi-sided objects, the Spiral 

Tool and the Graph Paper tool. 

 Perfect Shape Flyou-Accesses the collection of shapes you can add to your 

drawing. 

 Interactive Tool Flyout - Holds the Interactive Blend, Contour, 

Distortion, Drop Shadow, Envelope, Extrude, and Transparency Tools. 

 Eyedropper Tool Flyout-Holds the Eyedropper Tool and the Apply Tool for the color, 

effect, or property selected by the eyedropper 

 Outline Tool Flyout -Displays options for changing line 

color, styles, weights, and ends. 

 Fill Tool Flyout - Displays options for changing fill color, styles, 

creating custom colors, and removing fills. 

 Interactive Fill Flyout- Holds the Interactive Fountain Fill Tool and the Mesh Fill Tool. 

 

Page Navigation with the Page Selector 

A CorelDRAW file can have as many as 999 pages. A document of that length, however, might be 

created more easily in CorelVentura. To navigate a multi-page document you use the Page Navigator 

bar at the bottom left of the work window. From this bar you can add or move from one page to 

another. To delete pages you need to use the Delete Page command under the Layout menu. 
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1. Click on the Page 2 Tab. The Page 2 tab should be white. You can also use the Page Up and 

Page Down keys on the keyboard. 

2. Select the Page Tab for page 3.  The Add Page button should appear as this is the last page 

for this file. 

3.  Select the First Page arrow button to go back to page 1 

4.  Click on the 1 of 3 spaces. 

5.  Enter a 3 in the Go To box and click OK  

The Property Bar 

The Property Bar is located just under the Standard Toolbar. It is an interactive command center. Being 

interactive means that the options on the Property Bar change depending on the current task or command. It is 

designed to save time by interactively displaying commands as you work. You will work more with the 

Property bar as you progress. This section is meant only as an introduction. 

1. Select the Pick Tool . 

2. Place the cursor indicator on top of the purple rectangle and click. 

Small black handles appear designating a selection. You will learn about these later in the class. 

Notice the Property Bar changed to display a new set of options. 

3. Select the text. 

Again, new options display for working with text. 

Color Palettes 

The colorful row of boxes on the right of the screen is the Color Palette. CorelDRAW comes with 18 

color systems and gives you the ability to create your own palette. The palette can be floated 

or parked. The type of palette can be changed with the Windows menu, or the Color Palette Browser 

Docker. You may have several palettes open at once. 

Note: When you hold down a chip on the color palette, a box with shades of that color displays. 

(Shown below.) By dragging to one of the shades of the first color, you can choose a shade of a color 

quickly and apply it to a line or fill an object. 
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Keyboard shortcuts 

Adobe PageMaker keyboard shortcuts 

Alt + Space Bar - Open Control Menu Box 

Ctrl + N   - Create New Document/File 

Ctrl + O   - Open 

Ctrl + S -  Save  

Ctrl + Shift + S  - Save As  

Ctrl + W   - Close 

Ctrl + D  - Place A Vector/Raster/Image 

 Ctrl + Shift + P  - Document (Modify/Change) Setup  

Ctrl + P   - Print 

Ctrl + K  - General/Preference (View/Display) 

Ctrl + Q    - Quite/Exit  

Ctrl + A     - Select All (Text/Object) 

Ctrl + C    - Copy (Text/Object) 

Ctrl + V    - Paste (Text/Object) 

Ctrl + Z    - Undo (One Time) 

Ctrl + E    - Edit/Modify Story 
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General short forms and full forms in Computer 

Computer - Commonly Operated Machine Particularly Used in Technical and Educational Research 

1024 Bytes  -   1 Kilo Byte (KB) 

1024 GB  -   1 Tera Byte (TB) 

1024 KB    - 1 Mega Byte (MB) 

1024 MB    - 1 Gyga Byte (GB) 

1024 TB    - 1 Peta Byte (PB) 

8 Bits    -  1 Byte 

BIOS   - Basic Input Output System 

CD     - Compact Disk 

CPU   -  Central Processing Unit 

DVD     - Digital Video Disk 

EEPROM    - Electrically EPROM 

EPROM    - Erasable PROM 

FDD     - Floppy Disk Drive 

 GSM   –  Global System for Mobile Communication. 

CDMA –  Code Divison Multiple Access. 

UMTS  – Universal Mobile Telecommunication System. 

SIM   –  Subscriber Identity Module. 

AVI     - Audio Video Interleave 

SIS     - Symbian OS Installer File 

AMR    - Adaptive Multi-Rate Codec 

3GP    - 3rd Generation Project 

MP3    -  MPEG player lll 

MP4   -  MPEG-4 video file 

AAC     - Advanced Audio Coding 

GIF   -   Graphic Interchangeable Format 

JPEG    -  Joint Photographic Expert Group 

BMP     - Bitmap 

PNG   -   Portable Network Graphics 

DOC   -   Document  

HDD   -  Hard Disk Drive 
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HLL     - High Level Language 

HTTP   –  Hyper Text Transfer Protocol. 

HTTPS  –  Hyper Text Transfer Protocol Secure. 

 IP   –  Internet Protocol. 

URL   –  Uniform Resource Locator. 

VIRUS  –  Vital Information Resource Under Seized. 

3G   –  3rd Generation. 

I/O     - Input & Output 

IP     - Internet Protocol 

ISP    -  Internet Service Provider 

KBD     - Keyboard 

Kbps    -  Kilo Bytes per second 

LAN    -  Local Area Network 

LCD     - Liquid Crystal Display 

LED     - Light Embedded Diode 

LLL     - Low Level Language 
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